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Our Partner Resource Guide is provided to you as a service
and a guide. Within this guide, we cover many topics and
answer many frequently asked questions, but on the chance
that you have additional questions, we are always at your
disposal to answer your questions.

The printing industry is undergoing a transformation as
digital printing becomes more affordable and the quality
improves. This new technology is changing the way in
which all of us do business. How we prepare our files and
how we approach design — all of the old rules just don't
work. We welcome your questions to promote possible
savings in time and cost.
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This booklet was printed utilizing the digital NexPress on UDIGITAL #80
text and cover weight stock.



4-color black & white
with

30% magenta removed
35% yellow removed

o
Al

CMYK Image

4-color black & white
with
30% cyan removed

30% yellow removed ’






JOB REQUIREMENTS

OVERVIEW

Jobs that are sent into Printing Partners should adhere to these guidelines
as closely as possible. By meeting these guidelines, there is a greater
opportunity to reduce the overall cost of your job, by reducing the amount
of time that we spend altering, correcting or preparing your file. And
subsequently the faster it will move through our shop.

The requirements are fairly straight-forward and if you take them into
consideration prior to starting the job, they will not be a problem at the
completion of your job.

For Conventional jobs:

« All colors and images should be CMYK, Spot (PMS) colors should not be
altered and should be specified correctly.

* Images should be 300 dpi and placed at 100% in the document.

* |f the design calls for images or colors to bleed, there should be a
minimum of one-eighth of an inch (.125) bleed on all sides that trim.

e The document size should be the same as the trim size of the final
piece.

For NexPress jobs:

¢ All scans, if scanned in RGB, should remain in RGB.

* All digital photographs should be RGB

* Colors should be CMYK, Pantone colors should be used only from the
Pantone Color Bridge Library

* Images should be at 300 dpi and placed at 100% in the document.

* |f the design calls for images or colors to bleed, there should be a
minimum of one-eighth of an inch (.125) bleed on all sides that trim.

* The document size should be the same as the trim size of the final
piece.

Submitting Files

For PDF files:

Submitted PDF files should have been exported as high-resolution and
include bleeds and crop marks. A low-resolution (or “smallest file size”)
PDF will not print as desired.

For instructions on saving high resolution PDF files, please see the section
“PDF Settings” on page 4.

For Open files:

Open files are the editable files that exist in whichever program (Quark,
InDesign, lllustrator, Corel) it was created. When you send this type of file
to us, you will need to supply all of the elements that go with that job.
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JOB REQUIREMENTS

OVERVIEW

Items such as fonts, images, and any artwork that may have been placed
or used on your pages. If you are using Quark or InDesign this process has
been simplified by the manufacturer, all other programs will require that
you collect these elements manually. On a PC, this can be difficult when it
comes to locating your fonts.

With Quark and InDesign, there is a function within the program that will
gather all of the elements, including your fonts, and compress (ZIP) them
for sending. In Quark, it is called “Collect for Output;” InDesign calls it
“Package”.

QuarkXpress

In Quark, you should open your document and load your fonts. Check to
make sure all of your links are “ok” and then proceed to the “Collect for
Output” located under the File Menu. You will be presented with a dialog
box that asks where you want to save the document and what you want to
include in this collection. It is best if you create a new folder and include
the fonts, linked images, embedded images and layout. Once Quark is
finished, you will have a layout, fonts folder and picture folder in the folder
you created. Copy all of this to your media or compress (ZIP) the file and
send it to us. Quark will give you a warning about collecting fonts. It is true
that copying fonts and giving them to someone else is not legal, however,
for companies such as Printing Partners, you are allowed to give us copies
of the fonts you used in your job. It is our requirement to only use them for
your job. Your fonts will be used for your job only and then archived with
your job in case we need to re-run that job at a later date.

InDesign

In InDesign under the File Menu, select “Package...” A box will appear
asking for instructions. This gives you the opportunity to tell us what you
need done. This step is not necessary, so you can click Continue. You will
then be presented with a dialog box asking you to name the folder to save
the elements. At the bottom of the window are a series of check boxes,
these are your options of what to collect. The first three check boxes are
the most important, Copy Fonts, Copy Linked Images, Update Graphic
Links In Package. Click the Save button. Once InDesign is finished, copy
this folder to your media or compress (ZIP) the file and send it to us.
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JOB REQUIREMENTS

PDF SETTINGS

For Conventional Printing

Distiller or PDF Settings

Follow these general settings to create a high-resolution PDF for printing
output. As Acrobat is updated, some settings may be added, what is
shown below are the basics. If you have questions, please contact us.

General Settings

Compatibility: Acrobat 8
Object-Level Compression: Off
Auto-Rotate Pages: Off

Binding: Left

Resolution: 2400

Embed Thumbnails: No
Optimize For Fast Web View: No

Images

Color Images

Sampling: Bicubic Downsampling to 300 ppi
for images above 450 ppi

Compression: Off

Image Quality: Maximum

Grayscale Images

Sampling: Bicubic Downsampling to 300 ppi
for images above 450 ppi

Compression: Off

Image Quality: Maximum

Monochrome Images

Sampling: Bicubic Downsampling to 1200 ppi
for images above 1800 ppi

Compression: Off

Anti-Alias to gray: Off

Fonts

Embed All Fonts: Yes
Subset embedded fonts when percent of characters used is less
than 100%
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JOB REQUIREMENTS

PDF SETTINGS

Color

Adobe Color Settings

Settings File: None

Color Management Policies

Leave Color Unchanged

Document Rendering Intent: Preserve

Device-Dependent Data

Preserve Under Color Removal and Black Generation: No
When Transfer functions are found: Remove

Preserve Halftone Information: No

Advanced

Allow PostScript file to override PDF Settings: No
Allow PostScript XObjects: No

Convert gradients to smooth shades: Yes

Convert smooth lines to curves: No

Preserve Level 2 copypage semantics: Yes
Preserve Overprint Settings: Yes

Overprinting default is nonzero overprinting: Yes
Save Adobe PDF Settings inside PDF file: Yes
Save original JPEG images in PDF if possible: Yes
Save Portable Job Ticket inside PDF file: No

Use Prologue.ps and Epilogue.ps: No

Create Job Definition Format (JDF) file: No

Document Structuring Conventions (DCS)
Process DSC comments: No

Standard Reporting and Compliance
Compliance Standard: None
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JOB REQUIREMENTS

PDF SETTINGS

PDF Settings in InDesign

If you have Distiller, InDesign will list the settings you have for Distiller
in the settings list. Simply select the appropriate setting. If you do not
have distiller you can follow the same rules as listed on page 4. The only
additional screen you will have in InDesign will be for crop marks and
bleed. You will need to include crop marks and at least 1/8" of bleed.

PDF Settings in QuarkXpress

Under the Edit Menu, go to Output Styles. When the window opens, you
will see a list of all styles available. For our purposes use the style “Press
— High Quality/High Resolution” then click the Edit button. The preset
settings are fine, only the Marks will need to be adjusted. The Offset should
be 0.167-inches and Bleed should be 0.125-inches. Click okay and you
are finished.

Creating a PDF

Using Distiller

You will first need to make a PostScript file from the application you are
using. Once that file has been created, use Acrobat Distiller to create the
PDF.

Using InDesign

With the application open, go to the File Menu and select Export. Select
the correct Distiller settings and make sure you have selected Adobe PDF
(Print) from the list at the bottom of the Dialog box. Click Export and save
the PDF file to your hard drive.

Using QuarkXpress

With the application open, go to the File Menu and select Export >
Layout as PDF. The dialog box will ask you to choose a place to save the
document. You can limit the pages to be converted to PDF with the Pages
field, these page numbers correspond to the Page Layout window page
numbers. Select the PDF style “Press — High Quality/High Resolution”.
You can, if you need to, override the style settings, by clicking on the
Options button and making changes. These changes will only apply to
this PDF.
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MAILING REQUIREMENTS

MAILING INFORMATION

Cost-effective mailing starts with a good mailing list. We accept lists in
almost any format. Once we receive your list(s) we can:

* Merge multiple files

* Purge duplicate entries by checking names, addresses, or names
and addresses

 Correct and standardize address components and identify
deliverability

A critical part of mailing is an understanding of Post Office regulations.
To ensure the best postage rate we barcode mailings so they qualify for
automation rates. This means we must adhere to the following regulations:

* The mailing panel must have adequate room for a barcode.

e There may not be extraneous information that interferes with
optical scanning in restricted areas.

* The mailing indicia and any endorsements must be properly
worded.

Mailings with a nonprofit indicia must adhere to additional
regulations:

* There may be nothing “promotional” on or in the mail piece
(additional regulations may apply).

e The return address of the nonprofit entity must appear on the mail
piece.

 To receive the lowest nonprofit rate, the weight of the piece may
not exceed 3.3 ounces.

* When a response device is used, the business reply device address
must include the barcode and FIM in order to qualify for the lowest
postage rate.

Be sure to check PrintingPartners.net for the most up-to-date information.

Postcards

To qualify for postcard rates, a mail piece has to meet certain
requirements. You only receive a postcard postage discount for Presort First
Class or First Class Mail.

Shape: Rectangular

Minimum height of 3.5 inches
Maximum height of 4.25 inches
Minimum length of 5 inches
Maximum length of 6 inches
Minimum thickness: 0.007 inch

Maximum thickness: 0.016 inch
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MAILING REQUIREMENTS

MAILING INFORMATION

Additional restrictions:

Aspect ratio (length divided by height) must always be between 1.3 and
2.5 for automation postcards. If not, there is a nonmachinable surcharge
added to each piece.

Letter

To qualify as a letter, a mail piece has to meet certain requirements.
They are as follows:

Shape: Rectangular

Minimum height: 3.5 inches
Minimum length: 5 inches
Maximum height: 6.125 inches
Maximum length: 11.5 inches
Maximum thickness: 0.25 inch

Additional restrictions:

A surcharge applies to certain conditions including square, rigid and
unusually shaped envelopes that weigh one ounce or less. Minimum mail
piece thickness is .007 inch OR if the piece is more than 4.25 inches high
or more than 6 inches long the minimum paper thickness of the piece is
.009 inch.

Flats
To qualify as a flat, a mail piece has to meet certain size requirements.
Greater than 6.125 inches high or
Greater than 11.5 inches long or
Greater than .25 inch thick
And
Not more than 15 inches long or
Not more than 12 inches high or
Not more than .75 inch thick

Additional restrictions:
Minimum mail piece thickness is .007 inch OR if the piece is more than

4.25 inches high or more than 6 inches long the minimum thickness of the
piece is .009 inch.

See the next page for information on address placement on flats.

PARTNER RESOURCE GUIDE 9



MAILING REQUIREMENTS

MAILING INFORMATION

Flats Address Placement
The standards require:

The entire delivery address should be in the upper portion of all
Periodicals, Standard Mail, Bound Printed Matter, Media Mail, and
Library Mail flat-size pieces mailed at automation, presorted, or carrier
route prices.

i

The new standards define “upper
portion” as the top half of a H
mailpiece; however, we encourage
mailers to place the address as
close to the top edge as possible
(while still maintaining a 1/8-inch o s s e ot e
clearance from the edges). "

[A—

For enveloped or polywrapped 3 o |_ St
flat mail, the upper or top half is H = ‘
T

either of the shorter edges of the
mailpiece. For bound or folded flat
mail, the bound or final folded edge
must be vertical and on the right PE———
side, with an exception for Carrier .
Route (or Enhanced Carrier Route)

saturation mail, where either of the

shorter edges can be the top. If the delivery address is on an insert in
a polywrapped flat, address must remain in the upper half throughout
processing and delivery.

Ll

Mailers may place the address parallel or perpendicular to the top edge
within the upper portion of the mailpiece, but not upside down as read
in relation to the top edge.

If a vertical address does not fit in the upper half, address may pass
midpoint if placed within 1" of the top edge.

Mailers must also address ALL presorted, automation (this includes
First-Class Mail in addition to the classes of mail mentioned above), and
carrier route flat-size mailpieces using a minimum of 8-point type (.080”
high), with our preference being all caps and using a sans serif font, or;

If the mailpiece bears an Intelligent Mail® barcode with a delivery point
routing code for automation pricing, the address may be a minimum of
6-point type (.065" high) in all capital letters.

In addition, for ALL automation price pieces, the characters in the
address must not overlap, the address lines must not touch or overlap,
and each address element may be separated by no more than five blank
character spaces.

Postage and Delivery Address must be on the same side of the
mailpiece. Postage must be in the top, right corner of the mailpiece

or address area. Postage must have the same “read direction” as the
Delivery Address. This does not apply to Periodicals that are not required
to display postage.

10
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MAILING REQUIREMENTS

MAILING INFORMATION

Endorsements

Ancillary service endorsements are instructions printed on the address
side of your mail piece to give the Postal Service instructions on how to
handle your mail if it is undeliverable as addressed. These include Address
Service Requested, Return Service Requested, Forward Service Requested,
Temp Return Service Requested, and Change Service Requested. Most
endorsements are the same for all classes of mail, but the treatment and
cost differ by class of mail.

Address service requested

This endorsement instructs the Postal Service to forward priority, first class
and standard mail at no charge for the first 12 months. A separate address
notification is also provided to the sender for a fee. After 12 months,
additional information is provided and varying fees apply.

Return service requested

This endorsement instructs the Postal Service to return undeliverable mail
to the sender with address notification, or reason for nondelivery. There is
no charge for First Class mail. Standard mail is charged the appropriate
single piece First Class rate.

Forward service requested

This endorsement instructs the Postal Service to forward the mail piece
months 1 though 12 at no charge for First Class and Standard mail. After
12 months, additional information is provided and varying fees apply.

Change service requested

This endorsement instructs the Postal Service to provide the sender a
notice of new address or reason for nondelivery. The mail piece is disposed
by the Postal Service. Varying fees apply to Manual and Electronic notices
for Standard, Priority and First Class mail.

Temp-return service requested

This endorsement is only for First Class mail and there is no charge.

The mail piece is returned with a new address or reason for nondelivery
attached. If a temporary change of address piece is forwarded, no separate
notice of temporary change of address is provided to the customer.

For more information on mailing, visit www.usps.com.

Tips for Mail Piece Design

¢ On all folded booklet-style mailers — the bound edge should be on the
right hand side (leading edge) of the mail piece

* All mailing panels should be faced so the final folded edge is at the
bottom of the mail piece to minimize tab requirements

e For automation mail (Barcoded) — there MUST be at least an area of
4 inches wide by 2.75 inches tall of blank space to print the address &
barcode. These dimensions will ensure there is enough space around the
information so it can be read accurately on USPS machines.
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MAILING INFORMATION

Rate Options

An up-to-date listing of current USPS rate options is available on our
website: www.PrintingPartners.net/services/mailing.php
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TIPS AND HINTS

DESIGNING FOR DIGITAL

Why digital printing?

Whether your client works for an ad agency, a design studio, an in-house
design group, or as a freelance resource, you need to offer high-value
solutions, new ways of solving old problems, and more timely, more
effective ways of reaching and influencing customers. That's what digital
printing is all about.

Digital printing offers design freedom

Take advantage of high-quality, full-color printing that delivers results you'll
be proud of. With digital printing, you can get sharp text and lines plus
rich, detailed halftones. Moreover, digital printing supports an extremely
wide range of paper sizes, stocks, weights, and finishes (both coated and
uncoated). Because paper cost is often less of a factor in short-run printing,
you're likely to have the flexibility to specify papers that have previously
been out of reach.

Digital printing is fast

You always want to say “yes” to clients, even when they come to you with
“impossible” deadlines for new projects or updates. Digital printing makes
this easier, because it delivers high-quality printed pieces in hours, not
days. That speed makes digital printing a powerful tool for responding to
rapidly changing markets. And with far less available time allocated for
printing, more of the time is yours—giving you a better opportunity to do
work you'll be proud of. Electronic collation right on press offers fast results
for jobs that mix multiple weights or types of paper.

Digital printing supports variable data printing for maximum effectiveness

With traditional printing, every piece is identical. But with digital printing,
each printed piece can be customized in many ways. You can incorporate
a recipient’s name, location, or any information your database contains,
including images, colors and design elements. Messages targeted at
individual reader’s interests and needs with clear and relevant messages
are far more convincing and effective. They deliver higher response rates—
up to three times higher for direct mail. As a result of that efficiency, digital
printing’s cost per lead or sale is low, and its cost-effectiveness is high.

Digital printing makes short-run printing practical and cost-effective

With traditional printing, most of the cost is getting on press. While that
makes the per-piece cost of long runs attractive, it often makes short runs
prohibitively costly. That can mean missed opportunities for your clients—
and for you. Digital printing can make the shortest runs practical and cost-
effective, right down to printing just a single high-value piece.

14

PRINTING PARTNERS



TIPS AND HINTS

DESIGNING FOR DIGITAL

Choose digital production, and there’s never a need to print more than is
actually needed. That eliminates two of the biggest expenses in traditional
printing: storage and obsolete inventory.

Digital printing’s a natural

An all-digital printing process is the natural extension of your computer
and design applications. It works seamlessly and intuitively with the way
you work now. It's a natural for providing fast, powerful, innovative, cost-
effective solutions to your clients. As you learn more about digital printing,
you'll soon discover a whole new range of creative options never dreamt
of in the conventional print world. Digital printing systems like the Kodak
NexPress are a perfect choice for smaller quantities, print on-demand and
tight deadlines. Digital also excels when a project calls for a variety of
substrates or when a job requires several different versions. And, when it
comes to variable data printing, there is simply no other way.

Why the digital NexPress?

The digital NexPress is a unique printing solution. It combines the power
of a press with the flexibility of a printer. Like an offset press, the NexPress
digital press delivers high productivity and consistently top-quality pages.
At the same time, it provides the immediate turnaround and short-run
economy of a printer. The ability of the press to reproduce true color on a
variety of substrates—coated and uncoated—gives you the options most
digital printers can’t deliver. And because it's sheet-fed, you can choose
from a wide range of paper stocks and combine up to three different papers
in a single job. The technology of Kodak NexPress dry ink eliminates

the time-intensive drying process, enabling documents to go directly

to finishing. These features make the NexPress the right choice for the
higher-value print applications your clients need, including high-quality,
on-demand prints in short runs with quick turnarounds, fully customized
1-to-1 marketing materials and full-color collated pages that are ready to
be finished immediately. The NexPress was designed and built to meet the
requirements of jobs that demand quality, flexibility and speed.
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Secrets to great digital color
Print gamuts

Gamut is the term used to describe the range of colors that a specific
device can produce. If you're accustomed to designing within the
limitations of the traditional color gamut of the CMYK offset process, you'll
be pleasantly surprised to learn that the advanced technology of Kodak
NexPress dry inks make it possible to exceed that gamut by 20%. Your
computer monitor, however, can display many colors that are outside the
gamut of any printing process, even a 600-dpi digital printer. In the same
way, the inkjet or dye sublimation printer you may use to create proofs also
has its own distinctive color gamut. The bottom line: what you see on your
monitor or on your proof is not necessarily a good indication of the final
printed result. The best way to know exactly how your color will look is to
ask your printer to proof the job on the NexPress digital press. That's one
of the benefits of digital printing—proofs can be run on the same printer as
the final output.

Blacks and grays 100K

If you want to print a solid black

area, use a formula that combines 60C, 40M, 40Y, 100K
all CMYK colors to create a “rich” or (240%)
“super” black. A few sample formulas

are shown here and you can check 40C, 20M, 20Y, 100K

with your printer for other variations (180%)

that work well. If you're planning

to reverse white or light-colored type out of black, modify the formula to
a slightly less rich mixture. Here again, your printer is the best source of
information as you learn about the capabilities of digital printing.

For neutral shades of gray, use straight tints of black.
Spot colors

When printing digitally or 4-color process, you must be sure to use the
Pantone Color Bridge Library when creating swatches. Recently, Pantone
removed the CMYK builds from their Solid Spot Color Libraries. The new
Solid Spot Color Libraries only include Lab color builds to represent the
color on screen. If you attempt to digitally print a Solid Spot Color that only
has Lab builds, the RIP will attempt to convert the Lab build to a CMYK
build, which is inaccurate. See our blog post for more detailed information:
printingpartners.wordpress.com/2013/04/08/pantoneproblems.

Achieving the best printing results
Large areas of solid colors, tints and blends

There are several design techniques you'll want to learn to help improve
the way large flat areas of solid colors or tints reproduce on a digital press.
To maintain a smooth appearance, introduce a slight pattern to modulate
the color. The pattern can take the form of texture, subtle graphics or
simple noise. Adding a pattern can also improve color reproduction and
eliminate banding. The same holds true for color blends and gradients.

PRINTING PARTNERS



TIPS AND HINTS

DESIGNING FOR DIGITAL

Use all your design options

One of the best ways to optimize quality in large areas is to incorporate
imagery, photos, graphics or text in your design right from the start. When
you naturally break up large areas of color with design elements, you're
also taking advantage of one of the strengths of working on a digital
press—that is, the ability to reproduce high-quality, full-color images.

Tints and Blends

* Areas of solid color, tints and blends may reproduce better if
filtering techniques are used (i.e., noise or texture) at the design
stage. Apply from image manipulation software such as Adobe
Photoshop.

e Create blends from QuarkXPress, Adobe Photoshop and InDesign,
or other common desktop publishing applications.

e Tints should not be less than 10%.

e Limit blends to less than 50% value change over 2-4” for best
results.

e For tints less than 40%, apply noise or texture.
Photo reproduction

Sharp, crisp reproduction of photography and illustration is one of the
greatest strengths of the Kodak NexPress. The NexPress excels at skin
tones, highlight and lowlight detail, and rich, true color. So take full
advantage by maximizing the use of photographic images whenever
possible.

Text

With digital printing, your font choices and sizes are as limitless as they are
in conventional printing. And unlike most digital printers, the NexPress can
print 4 point black type clearly and legibly.

Dot gain

You've probably found yourself dealing with optical and mechanical dot
gain. With the electrophoto-graphic technology of the NexPress, the dot
gain is constant and a routine calibration controls the dot gain for all
conditions. You should not have to make any adjustments to your files.

Dry ink coverage

While it would be technically possible to print 100% of each process color
for a total coverage of 400%, it's not necessary nor recommended. On
page 16, you saw how to create rich blacks and the total coverage of the
recommended formulas ranged from 180% to 240%. For the NexPress,
the maximum dry ink coverage is 280%. With more excessive coverage, a
buildup of layers may become noticeable. If 280% coverage is exceeded in
the file, it will be reduced to 280% automatically by the NexPress.
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Examples of maximum coverage

C70% C 0%

M 55% Total M 100% Total
coverage: coverage:

Y 55% 280% Y 100% 280%

K 100% K 80%

Scanning and scan resolution

Scan continuous tone images at a resolution that will provide 300 dpi

as the final layout size. Higher resolutions only increase raster image
processing (RIP) time with little or no visible improvement in image quality.
Perform all scaling, rotation and manipulation of your images in your image
editing application before placing them in your layout.

Scanning
* Scan continuous tone images for 300 dpi at final size.
 Scan line art at a minimum of 600 dpi, up to 1200dpi.

* To capture a larger color gamut, scan continuous-tone images in
RGB or Lab Color mode rather than in CMYK mode. (This is only if
your job will be printed on the NexPress, otherwise using CMYK is
recommended)

» Save at 100% of final size and orientation.
* Do not include screen angles or transfer functions.
* Using compression can result in image degradation.

* TIFF (for images) and EPS (for graphics) are usually acceptable.

Keys to a clean finish

Bleeds

Prepare jobs that bleed in exactly the same way as you would for
conventional printing with an extra 0.125 inch (3mm) to allow for
trimming on the bleed edges. For die cut jobs, increase your bleed to 0.25
inch (6 mm) to anticipate possible movement on finishing devices.

Imposition, folding and finishing

With the NexPress, you can set up your documents as 2-page reader
spreads, or 1- or 2-page printer spreads. Automatic imposition software
handles the setup and proper sequencing, but it’s still a good idea to give
us a mock-up of your layout to avoid any possible misunderstandings.
Remember to allow the proper amount of space in the gutter for the
binding process you will be using.
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DESIGNING FOR DIGITAL

When it comes to folding, one concern with electrophotographic imaging
systems is cracking in heavy-coverage areas. You can reduce the possibility
of cracking by designing your job with less coverage on areas to be folded.
Whenever possible, design your job to fold with the grain of the paper, not
against the grain. For best results, score all folds. If you gloss coat the final
pages—especially covers—you can reduce cracking and provide a durable,
finished look.

The NexPress has a fifth imaging solution for clear overcoating with clear
dry ink. Ask your salesperson. (See also page 40)

Trimming and binding

Virtually all commonly used binding methods are available for use

with digitally printed documents. If you're taking advantage of the fast
turnaround possible with digital printing, you'll probably want to keep your
binding options simple to save time. We recommend saddle-stitching and
coil binding for fast turn-times, but perfect binding is also an option with
the NexPress.

File preparation
File preparation tips

In addition to designing your document to take full advantage of digital
printing’s unique capabilities, proper file preparation is essential to ensure
that your job runs smoothly. You can supply open files or final PDF files to
your printer. Before creating a PDF for the NexPress, contact your printer
and request the Distiller Job Options file. Place this into your Distiller
Settings folder before you create the PDF.

The NexPress performs at peak efficiency with any standard desktop
application that produces PDF and PostScript files. It is a good idea to
supply us with your open files as well. This will allow us to make any
necessary adjustments faster and easier.

How to avoid font conflicts
* Use Type 1 standard PostScript fonts or TrueType Fonts.
* Do not use Multiple Master fonts.

* Do not apply font styles from the menu or keyboard; choose the
correct version of the font from your type menu. (e.g., use Times
New Roman Bold; do not apply “bold” to a regular font.)

PARTNER RESOURCE GUIDE 19



DESIGNING FOR DIGITAL

Job submission checklist

Be sure to include all screen and printer fonts used in your document,
including those embedded in image files. Include separate fonts for styles
within font families.

* Provide a printed file directory for reference.

* Provide a hard-copy or PDF proof to indicate page elements and
sequence.

* |f necessary, include an imposition layout or mock-up of the final
design.

* Make sure all trapping options are turned off. Inform us if you have
done any trapping yourself.

* Make sure that all artwork has been converted to CMYK or RGB,
depending on if the job is printing conventionally or digitally.

 Collect all linked files, fonts, images and page elements for output.
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General Font Handling Rules

In applications, use the actual stylized typeface if it is available, avoiding
the use of style attributes such as bold, italic, bold italic, outline and
shadow.

You should use higher quality postscript, true type or open type fonts.
Some inexpensive and free fonts may not print correctly.

Hard-Copy Proofs

It is our experience that hard copy proofs are vital to insure the integrity of
the final output. Clients should provide the following with every project:

1. A hard-copy proof or PDF proof. Printing Partners will not be held
responsible for the integrity of the imposition proof without a hard-
copy proof since this is compared to the final as a quality-control
measure.

2. Hard-copy or PDF proofs must match the supplied electronic files.
This is absolutely critical to the internal quality/review process.

3. On all files which are sent by web or email, the client should
provide a PDF to show position & approximate color. A low
resolution PDF is acceptable if you are sending open files.

4. Printing Partners will not be held responsible for the integrity of the
final piece without a hard-copy or PDF proof.

If you have submitted a file without a hard-copy proof, Printing Partners
will:

1. Produce a proof from the electronic file.

2. Compare the printout to the PDF proof or send it to the client for
approval.

3. Await the client’s approval to proceed.

4. Only after approval by the client, salesperson or CSR acting on
behalf of the client, will Printing Partners process the job.
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Hard-Copy Proof Specifications

* Your proofs should be 100% in size. Tiling may be necessary, and
is preferred to off-size proofs. Proofs not at 100% size create quality
control problems such as checking text, subject position, etc.

Make sure you consider the print area of your printer. Some printers
have a non-printable border.

Print proof with file name, crop marks, date and time. Click the
registration marks option in the print dialog box when using
programs that support this feature.

For a spot or process color project, color proofs are preferred. Color
proofs can give us insight into color breaks, the status of imagery
(color or black and white), and any potential trapping problems to
watch out for.

If you are relying on black and white laser proofs, grayscale mode
should be used when printing proofs of color pages. Black & white
proofs of color pages should be printed with “Colors as Gray” turned
on.

Tiled proofs should be complete and taped together as a page or a
spread.

Handwritten instructions can clarify aspects of your proof, making
the project easier to process.

Fifth or spot colors should be labeled. This assists us in
understanding if a color needs to be a spot color or a process tint
match.
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Submitting Revisions or Corrections

A client can save money through the use of the guidelines for electronic
prepress, by helping to ensure that the work is right the first time, thus
eliminating the need for most author’s alterations (AAs). However, in the
course of producing a project, AAs will sometimes happen. In order to
expedite an AA in the most cost-effective manner, we recommend the
following:

* All changes should be marked on the most recent vendor-supplied
proof. Do not mark changes on the originally submitted design proof
that you included with the disk.

» Text and mechanical changes must be made to the computer file
and saved as a revised file with a new electronic file name. This new
name should include the suffix *_R1". For example, if your original
file name were ‘Sales Broch’, the new name should be ‘Sales
Broch_R1'.

* A new hard-copy proof should be created of the revised file, using
the guidelines discussed above.

The items you should then ship to your vendor include:
* Marked-up, most recently vendor-supplied proof.
* Hard-copy proof of the revised file that includes your AA's.
* Revised computer file, (correctly renamed with _R1, R2, etc.)

If only color corrections to 4/C images are to be made and you wish us
to correct the color, submit only the marked up vendor—supplied proof.

If you have modified imported live images, you must re-submit these
files. In this instance, do not rename the imported illustrations or scans,
since they have been already imported into your layout document. You
may wish to open up your layout document and update the links, to
ensure that cropping and placement issues have not been altered by your
modifications.

If you do not follow the above procedures, the submitted AA electronic
file typically will be produced from scratch, as if it were a completely new
submitted electronic file.

If you cannot produce a current hard copy proof that matches the
electronic file due to last minute changes, you can send us a PDF proof
via email.
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File Naming Recommendations

Any new file submitted must have a unique file name. No two electronic
files should have the same exact name. Revisions of the electronic files
should not use the same name as the unrevised file.

Text Handling and Text Special Effects

Reverses

The words “REVERSE” or “DROP OUT” may be used interchangeably.
For the offset printing process, define a reverse using the default color
“WHITE" that exists in your application’s color palette.

Outlines

Text outlines should be created in drawing programs and saved as an
EPS file for outline effect. To create an outline in Adobe lllustrator or other
object-oriented drawing programs, do the following:

1. Set the original text in a text box applying all attributes of kerning,
font, point size, leading, horizontal scaling, color, etc.

2. When text is final, save the document for future editing.
3. Convert text to outline in lllustrator .

4. If you use 100% black stroke or fill, set the black stroke or fill
to overprint in Illustrator. If you plan on having your vendor do
trapping, you should not set color stroke or fill to overprint or
surprint, even if that is the eventual effect you are looking for. Make
sure you make these requests clear on your proof.

5. Save in lllustrator.
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Drop Shadows without Outlines

Drop shadows can either be created within the page layout program or by
using a drawing program that will produce an EPS file. It is very important
to note that a shadow be a separate, editable and definable element. Do
not use the “SHADOW?" attribute from the type style dialog box. You may
use the shadow effect in Quark or InDesign, but remember that combining
shadows and spot colors may create problems.

The preferred method of creating a simple drop shadow (no outline
included) is as follows:

1. Set the original text in a text box on pasteboard applying all
attributes of kerning, font, point size, leading, horizontal scaling,
etc.

2. Select “Step and Repeat” to duplicate text at the desired shadow
offset.

3. Apply color/tint to shadow text.
4. Send shadow text box behind.

5. Select original text box and make it transparent by selecting None
for color background under the Modify menu.

6. Group the two text boxes and position on layout.

Drop Shadows with Outlines
This is an alternative method of producing a drop shadow if outline is
involved, using Adobe lllustrator:

1. Set the original text in a text box applying all attributes of kerning,
font, point size, leading, horizontal scaling, color etc.

. When text is final, save for future editing.

. Convert text to outline

. Select “Copy and Paste in Front”

. Create the proper offset by moving new text.
. Apply shadow color/tint.

N Oy o bW N

. If you use 100% black stroke or fill on either layer, set the black
stroke or fill to overprint in Illustrator. If you plan on having your
vendor do trapping, you should not set color stroke or fill to
overprint, even if that is the eventual effect you are looking for.
Make sure you make these requests clear on your proof.

8. Send shadow text behind.
9. Group together.
10. Save in lllustrator.
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Trapping

The responsibility to set traps is a workflow decision that should be
discussed.

We do not require the client to do trapping, preferring that the client
prepare files in @ manner consistent to the guidelines. This will assist us in
applying and being responsible for trapping.

Rules, Frames (Borders) Specifications

The words “FRAME,” “STROKE"” and “BORDER” may be used interchangeably.
The words “RULE” and “LINE” may be used interchangeably.

Rule Specifications

Do not use a predefined “HAIRLINE” width rule in any application. Keep
in mind that predefined hairline rules vary in width between different
applications and output devices. This is a very imprecise tool, which can
become totally unusable when output on a high-resolution device such as
an imagesetter. Instead, define your own hairline width rules as .25 point.

Caution should be taken when using paragraph rules in QuarkXPress. For
example, when using rule above or below, the rule takes on the text inset
of the text box.

Wherever possible, do not use rules to create frames. It's extremely difficult
to align rules to create perfect corners. Even though certain sides of frames
(such as in the creation of ads) may be bled off the page, it is highly
recommended to use frame options within the applications, even if that
means that part of the frame bleeds off the page.

Importing Graphics
Live images (not including EPS files)

A live image is any image element in an electronic layout file that will be
incorporated in the final document. These can include scans, other digitally
captured images (digital camera, Photo CD or video frame grabber) or
computer-generated art.

Any live computer image files should be supplied in a CMYK format, as
opposed to RGB. Conversion to CMYK from RGB can be accomplished
in Adobe Photoshop. It is best to have the scans created as CMYK on

a scanner that supports this feature, since the RGB/CMYK conversion
algorithms in desktop programs can be unpredictable. If you are printing
digitally, you can leave these files as RGB.

Encapsulated Postscript (EPS) images

Page layout programs treat EPS files as electronic pickups. After placing
EPS files in a page layout document, do not rename EPS files. The EPS file
name is the link between the page layout document and the EPS file.
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Defining Colors

When defining colors, you should reference a printed tint guide before
entering values in the color palette because RGB color monitors do not
accurately represent ink on paper, whether CMYK tints or Pantone spot
colors. This is because of the different color gamuts associated with
printing vs. monitors.

Process vs. Spot Colors

Many desktop programs allow you to specify colors in three ways: You can
specify a spot color by product name such as Pantone, a process color by
setting CMYK percentages, and process color tints based on pre-defined
systems such as TruMatch and FocolTone.

When specifying spot colors, be sure to use the appropriate spot color
libraries when creating your swatches.

When specifying process tint matches it is important that you use the
Pantone Color Bridge Library when creating your swatches. Because
Pantone has recently removed the CMYK building from their spot color
libraries, you MUST use the Color Bridge Library or your colors will
print incorrectly. For more information on this, view our blog post:
printingpartners.wordpress.com/2013/04/08/pantoneproblems.

We recommend that you always specify tint percentages using the
TruMatch or FocolTone system. Whenever specifying colors, always work
from printed swatchbooks, not what you see on the screen.

Transparency

QuarkXpress, InDesign and lllustrator all offer transparency effects within
the applications. This includes transparent colors as well as drop shadows.
While this effect will look correct on your screen and in most cases it will
look correct in your PDF, there can be issues when we prepare your file for
printing.

The problem arises when transparency and spot colors are used together.
When you specify transparency, any color that is affected by the
transparency is rasterized in CMYK. If all affected colors are CMYK, then
there is no problem. However, if any of the colors are spot colors, the color
may shift when it is rasterized. Also, when we produce printing plates for
the job, your spot colors will now be 4-color and will not print correctly.

The solution. If you are working with a spot color and transparency, you
can send us the open files, or after proofing and approvals, switch your
spot color over to either cyan, magenta or yellow. We can then “map” that
color back to your spot color for printing. The contract proofs we produce
for you will show the colors after they have been mapped. If you have
any questions on how to handle this type of situation, please contact your
salesperson or CSR and they can answer any questions you might have.
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Creating and defining EPS files

Try to minimize the nesting of EPS files. Printing an EPS within an EPS
increases the chance that the file will not RIP correctly in PostScript.
Generally, if it won't print to your PostScript laser printer, chances are we
may have the same or similar problems during production. Nesting EPS
files also creates linking problems between applications that may cause
unpredictable results.

To get the same results as nesting using Adobe lllustrator, “Open and Copy”
illustrations instead of “PLACE".

You should restrict object-oriented EPS illustration files to single subjects.
In other words, do not have several illustrations in one EPS file that are
usually viewed in individual graphic boxes or windows. For example, don't
put multiple logos in one EPS file if they are individually cropped for use in
your layouts.

The reason for restricting to a single subject is that every time you place
the EPS file, the PostScript RIP (both your laser printer and our high
resolution RIP) has to process the entire EPS file even though only a
small part is showing through the cropped windows. This can result in
productivity losses.

If you use 100% black stroke or fill, set the black stroke or fill to overprint
in lllustrator. Generally, do not set other colors, stroke or fill, to overprint.

When creating your EPS illustrations, convert all text to outlines to
eliminate font calls and ensure font compatibility at production time.

Convert to outlines. Beware that some typefaces in smaller sizes may not
be suitable to convert to paths.

UPC codes

UPC codes are available in an approved EPS file form. It is strongly
recommended that you do not try to create your own UPC barcode. It is
extremely difficult to meet all the UPC guidelines.
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Did You Know?

The printing press was a very important invention that changed

the way people communicated with each other and shared ideas.
Printers could make books faster, which meant that knowledge
could be spread more widely, and more people learned how to read.

Here are some interesting facts about printing:

1. It took almost two years to produce Shakespeare's First Folio.
The First Folio was printed in 1623 and was the first time that
Shakespeare’s plays had been published together.

2. Johannes Gutenberg adapted a wine press to make the first
printing press around 1439. Instead of pressing grapes, the
equipment pressed metal letter forms onto sheets of paper,
parchment, or vellum. Gutenberg was a professional goldsmith
who used his metalworking skills to make the first set of movable
type in Europe!

3. When books were made by hand, scribes used water-based inks;
these inks did not stick to printed pages very well, so printers
had to invent oil-based inks. The oil-based inks spread over the
metal type more evenly. Printers sometimes used ingredients
from their homes to create inks. Soot, for example, made a good
homemade black ink.

4. Mexico had a working printing press in 1534—before Ireland,
Russia, or America! The first American printing
press was started in Cambridge, MA in
1639. Jose Glover came from England
with his family to open the first print
shop, but he died either during
the journey or very soon after his
arrival. His widow and one of
the assistants, Stephen Daye,
successfully started America’s
first print shop.

5. Each piece of movable type, including letter
forms, punctuation, and blank spaces, was
originally made by hand. Some printers
created their own typefaces, also called
fonts. Some of these fonts are still used
today. Garamond, for example, is on
many computers and is named after the
French printer Claude Garamond.
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TYPES OF FOLDS

Folds come in two types: parallel and right angle. The folds you make
before you put a standard-size sheet of paper into a business envelope
are good examples of parallel folding; two creases in the same direction,
ideally along the paper grain.

A right angle fold is two or more folds, with each fold at 90 degree angles
to the one before it.

To make clean folds, many jobs require small variations in panel size.
While they may look similar, individual panels are sized at slight differences
to accommodate paper thickness.

It's also worth remembering that the more folds you have, the lighter the
weight of paper required. That's because heavier stock may build up too
much thickness to roll into itself a number of times, or may require wider
scoring to minimize possible cracking.

Don't be offended if we ask if you'd like to see a paper dummy. We're not
implying anything — we're just offering a preliminary layout made from
blank sheets of paper folded and bound with the correct number of pages
and folds in the weight you desire to give you an accurate representation of
the final piece.

Paper Grain

Paper is made up of fibers and they are arranged to go in the same
direction. If we bend paper at a 90 degree angle to the fibers, they will
crack. If the fibers crack, the ink will fall off and there will be cracking in
the fold. If we fold the paper with the grain, it will fold smoothly with very
little disruption to the ink.

This is important when we order paper. We need to know how the piece
will fold and how we will place the piece on the press sheet when it prints.
This allows us to make sure the grain of the paper is going parallel with the
folds. This way your piece will look its best when it finished.

Types of Folds

Tri-Fold

A tri-fold piece has six panels, three inside and
three outside. The panel that folds inside needs
to be smaller than the other panels. This gives
room for the paper to fold without binding.
Depending on paper stock, the size difference
can be a 1/16 of an inch or 1/8 of an inch. The
best rule of thumb is to make the panel 1/8 of
an inch shorter to allow plenty of room to fold.

Panels 1 & 2 are outside
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Double Parallel Fold

Folding in this way gives you

8 panels. All four panels are of
equal size, so simply divide your
length by four.

Roll Fold

Panels 1 & 2 are outside

With a roll fold, the number of
panels you have is up to you. The
best way to figure this fold out is
to determine what the finished
size of your piece is going to be.
That height and width size is
the dimensions of the first two
panels. Each panel from here on
will be 1/8 of an inch smaller
than the one that proceeds it.
The panels keep getting smaller
in width as you go.

Gate Fold

Panels 1 & 2 are outside

This will give you 6 panels. If you
open it flat, you will be looking at
3 panels. The two on the outer
edges will be 1/2 the size of the
center panel. The two panels that
fold in do not always touch, there
can be a slight gap. Also, text
that runs across the gap may not
line-up perfectly.

Panels 1 & 3 are outside

Double Gate Fold

In a Double Gate Fold, you have
four panels. Panels 2 & 3 are the
same dimensions as your finished
piece. Panels 1 & 4 fold into the
other two panels and can be 1/8”
or 1/16" shorter. The heavier

the paper stock, the shorter the
panels will need to be to allow
the paper to fold without binding.

Panels 2 & 3 are outside
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Z-Fold

Gives you six panels, all panels
are the same size. No panel folds
into another, so you don't have to
allow for extra space.

Accordion Fold

With an Accordion Fold, all
panels are the same size.

Panels 1 & 4 are outside
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3-Hole Drill

This is a standard drill to allow the paper to be put into a 3-ring binder.
Drilling can be specified in many different configurations to meet different
requirements.

Saddle Stitch

A binding where the paper is folded in half and staples are placed in the
fold to hold the pages together. Depending on the paper stock, this binding
option is for smaller page counts.

Perfect Bind

A binding where the pages are glued together. Typically used for paper-
back books. The page count can vary greatly. We recommend that a perfect
bound book have a minimum thickness of .125-inches.

There is no minimum page count, because paper can vary in thickness
depending on what weight paper you are printing on.

Coil / Wire-o / Spiral Bind

A binding method where a plastic or wire coil is wound through holes in
the paper to hold the book together. A typical example would be spiral note
books.

Case or Edition binding

A binding method similar to perfect bind that finishes as a hard cover
book.

GBC Bind

Also commonly known as a comb bind, a GBC bind is a plastic comb that
is fed through punched holes. GBC binding comes in various sizes.
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DIE CUTTING AND FOIL STAMPING

Both of these processes require a die, the difference being that one cuts
and one stamps. Additional time will be needed once your final proofs have
been approved in order to have a die created.

Die Cutting

Depending on what you are cutting, the
die can be slightly different. When you
cut, you can also score the paper so
that it folds correctly. When you create
your die, solid lines are used to indicate
cut marks and dotted lines are used to
indicate scores. If you are replicating a ;
pocket folder, sometimes it helps to take A door hanger cutting die
an old one apart so you have an example loaded in the press

to go by. Generally, you will create the die
in a drawing program such as lllustrator. It
can also be created in Quark or InDesign.

Creating the cutting die

Depending on the company you are sending the die to, there are different
requirements. Some companies create the die by pounding metal strips
into wood, this process is done by hand and generally is done from a
printout of the file you create. Some companies use a laser system to
create the die and they work from an electronic file.

Glue Tabs

These are important to getting a good finished product. The tab should be
at least 3/4 of an inch to allow for good glue coverage. Generally, you do
not want ink on the tab, 1/8 of an inch for color bleed is acceptable. Glue
may not stick to some inks, so as a general rule ink is not printed on the
tabs.

Embossing / Debossing / Foil Stamping Dies

These dies are created from black and white artwork. Grey values are

not allowed. The black area of the die is the part that will make contact
with the paper. So if it is a foil die, that is the area that will have foil. In
embossing / debossing, it is the area to be raised or lowered. Typically they
are created from electronic files.

Mock up

Die cutting can be an intricate process and mistakes can get expensive.

It is best to mock up what you have created once the file for the die is
complete, print it out at 100%, even if it requires tiling the document.
Once it is printed out, cut and fold the die along the lines you have made.
Check to see if the folded piece is correct. If not, you will need to fix your
die. Once it is correct, send us a copy of the finished mock up so we
understand what you are trying to accomplish. This way we can make sure
everyone is communicating correctly.
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Spot Varnish

A spot varnish is a varnish that is put on only a portion of the page. It can
be gloss or dull and is used to highlight or emphasize a photo or text, or
can be used as a subtle design element. A spot varnish requires that a
special plate be created for the press. It is treated as an additional color.
Spot varnishes can be solids or screens; you can have almost as much
control over a spot varnish as you would a spot color. Some spot varnishes
can also be tinted to create an effect. If your printer has the ability, you can
also mix dull and gloss so you can have both on one piece.

Flood Varnish

A flood varnish is a varnish that goes over the entire page; it covers
everything. Flood varnishes can be gloss or dull, and they can be tinted if
needed. A flood varnish can be gloss or dull but not both. You can have a
flood with a spot varnish — depending on your printer and what they use for
varnishes, this process can be different, so speak with them if you want to
mix it up a little.

Aqueous Coating

An aqueous coating is similar to a flood varnish. Aqueous coatings are
faster drying and more cost-effective. They aren’t quite as glossy or
dramatically dull as a flood varnish would be. In most instances, an
aqueous coating is a good alternative. Speak to your salesperson about
which might work best in your situation.

Dull Varnish

Just as you have dull paper, you can have a dull varnish. It produces an
area on the piece that will not reflect light in the same manner; it can
make colors fade into the background. It can also feel a little rough to the
touch, depending on the varnish used.

Gloss Varnish

Like gloss paper, a gloss varnish can make colors pop. It can protect
certain inks as well. Metallic inks or deep rich colors like a four color black
tend to show finger prints and scuffing, so covering them with a varnish
helps to hide the finger prints and protects it from scuffs.

Raised Clear Ink

The NexPress has capabilities to print raised clear ink to create a tactile
experience. You can use different tints while designing to create different
heights of the raised clear ink. The set-up process is very specific. Ask your
salesperson for a “Kodak NexPress Dimensional Printing System Creative
and File Preparation Guidelines” book for more details.

Glosser

A digital flood gloss varnish. It really isn’t a varnish, it almost feels like

a lamination, but it is different from that as well. It adds a very glossy
surface to the digitally-printed piece. This can be performed only on certain
digital presses, so check with your printer first.
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Dry Ink

Digital presses use a dry ink to create a dull or matte finish on printed
pieces. It can work very much like a dull spot varnish. These inks can also
be tinted to enhance other colors. You can not mix these colors. Not all
digital presses have this capability, so check with your printer.

A Dry Ink color for the NexPress starts in your graphics or page layout
programs. The name must be specified correctly in order for the NexPress
front end to recognize the colors you are specifying.

All of these colors are defined in the color palette and are used like any
other color you have used in the past. the difference is what they are
named and how they are specified. These colors are LAB colors.
NexPress Drylnk clear
This color is called: NexPress Drylnk clear and is defined as:
Ink Name L A B
NexPress Drylnk clear 10 0 0
NexPress Drylnk red
This color is called: NexPress Drylnk red and is defined as:
Ink Name L A B
NexPress Drylnk red 56.7 69.3 59
NexPress Drylnk blue
This color is called: NexPress Drylnk blue and is defined as:
Ink Name L A B
NexPress Drylnk blue 30.2 17.6 -69.9
NexPress Drylnk green
This color is called: NexPress Drylnk green and is defined as:

Ink Name L A B
NexPress Drylnk green  60.2  -749 1.8

Once these colors are defined in Quark, InDesign or Illustrator, you can

use them like a normal spot varnish. If you use this color with an image,
such as a bitmapped tiff or colorizing an image with it, you will need to tell
that image to overprint. If you do not, the software will knock out the color
under it and you will lose the effect.

To specify image overprint in Quark

Go to the trapping dialog box, select the image you want to use the Drylnk
with and then in the Trap Information window, click on the pulldown menu
for Picture and select Overprint.
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OVERPRINT

To specify overprint in InDesign

Overprint is a little different in InDesign. Once you have created your text,
color block or image and placed them where you want them, you can
select them and use the Attributes dialog box to tell them to overprint. This
will only work with images that are grayscale and are colored in InDesign.

To specify overprint in lllustrator

Overprint in Illustrator is very similar to InDesign. Create your art, and
then select the part you want to overprint. In the Attributes dialog, you
can select the fill or stroke to overprint. Remember, colors created in
[llustrator will need to be named and specified the same way in order for
the NexPress front end to recognize that they are dry inks.
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Equivalents Chart

Inches Inches
Fraction Decimal Millimeter Fraction Decimal Millimeter
1/64 0.015625 0.397 33/64  0.515625 13.097
1/32 0.03125 0.794 17/32  0.53125 13.494
3/64 0.046875 1.191 35/64  0.546875 13.891
1/16 0.0625 1.5688 9/16 (OR167245) 14.288
5/64 0.078125 1.984 37/64  0.578125 14.684
3/32 0.09375 2.381 19/32  0.59375 15.081
7/64 0.109375 2.778 39/64  0.609375 15.478
1/8 0.125 3.175 5/8 0.625 15.875
9/64 0.140625 3.572 41/64  0.640625 16.272
5/32 0.15625 3.969 21/32  0.65625 16.669
11/64  0.171875 4.366 43/64  0.671875 17.066
3/16 0.1875 4.763 11/16  0.6875 17.463
13/64  0.203125 5.159 45/64  0.703125 17.859
7/32 0.21875 5.556 23/32  0.71875 18.256
15/64  0.234375 5.953 47/64  0.734375 18.653
1/4 0.25 6.350 3/4 0.75 19.050
17/64  0.265625 6.747 49/64  0.765625 19.447
9/32 0.28125 7.144 25/32  0.78125 19.844
19/64  0.296875 7.541 51/64  0.796875 20.241
5/16 0.3125 7.938 13/16  0.8125 20.638
21/64  0.328125 8.334 53/64  0.828125 21.034
11/32  0.34375 8.731 27/32  0.84375 21.431
23/64  0.359375 9.128 55/64  0.859375 21.828
3/8 0.375 9.525 7/8 0.875 22.225
25/64  0.390625 9.922 57/64  0.890625 22.622
13/32  0.40625 10.319 29/32  0.90625 23.019
27/64  0.421875 10.716 = 59/64  0.921875 23.416
7/16 0.4375 11.113 15/16  0.9375 23.813
29/64  0.453125 11.509  61/64  0.953125 24.209
15/32  0.46875 11.906 31/32  0.96875 24.606

31/64  0.484375 12.303 63/64  0.984375 25.003
172 .5 12.700 1 1.0 25.400
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